
iW
or

x S
am

ple
 La

b

Experiment HH-1: The Electrocardiogram and Peripheral Circulation

Background

The cardiac cycle involves the sequential contractions of the atria and the ventricles which are triggered 
by action potentials in the myocardial cells. The combined electrical activity of the myocardial cells 
produces electrical currents that spread through the body fluids. These currents are large and detectable 
by recording through electrodes placed on the skin. The regular pattern of signals produced by the heart 
is called the electrocardiogram or ECG (Figure HH-1-B1).

Figure HH-1-B1: ECG recording displayed in the Main window with labels showing the P, QRS, and T 
waves. 

The components of the ECG are correlated to electrical activity in the atria and ventricles such that:

• Atrial depolarization produces the P wave.

• Atrial repolarization and ventricular depolarization produce the QRS complex.

• Ventricular repolarization produces the T wave.

The depolarization of the myocardial cells in the ventricle causes the ventricles to contract and force 
blood into the major arteries of the circulatory system in a pulsatile manner. 

In this experiment, you will record a single lead ECG. You will also examine the effects of temperature 
changes in the periphery on heart rate.
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Experiment HH-1: The Electrocardiogram and Peripheral Circulation

Equipment Required

PC or Mac computer

USB cable

IX-EEG data recorder

Three snap electrode lead wires

Stethoscope

Alcohol swabs

Disposable ECG electrodes

Ice, cold and hot water, plastic bags

IX-EEG Setup

Use the USB cable to connect the computer to the USB port on the IX-EEG data recorder. 

Start the Software

1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is 
not available, click on the Windows Start menu, move the cursor to All Programs and then to 
the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window 
will appear as the program opens. There will be a message indicating that LabScribe has 
recognized the IX-EEG.

2. On the Main window, pull down the Settings menu and select Load Group.

3. Locate the folder that contains the settings group, IXEEG.iwxgrp. Select this group and click 
Open.

4. Pull down the Settings menu again. Select the ECG-Circulation settings file from Human Heart.

5. After a short time, LabScribe will appear on the computer screen as configured by the ECG-
Circulation settings.

6. For your information, the settings used to configure the LabScribe software and the IX-EEG 
unit for this experiment are programmed on the Preferences Dialog window which can be 
viewed by selecting Preferences from the Edit menu on the LabScribe Main window.

7. Once the settings file has been loaded, click the Experiment button on the toolbar to open the 
associated pdf files. 

ECG Cable Setup

1. Locate the red, black, and green electrode lead wires (Figure HH-1-S1) in the IX-EEG kit.

2. Insert the connectors on the red, black, and green electrode lead wires into the matching sockets 
on the IX-EEG.
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3. Instruct the subject to remove all jewelry from their wrists and ankles.  Another option is to use 
the area just under each clavicle which will give a better recording.

4. Use an alcohol swab to clean and scrub a region with little or no hair, on the inside of the 
subject’s right wrist/clavicle. Let the area dry.

5. Remove a disposable ECG electrode from its plastic shield, and apply the electrode to the 
scrubbed area on the wrist or under the clavicle.

6. Repeat Steps 6 and 7 for the inside of the left wrist/clavicle and the inside of the right ankle or 
lower right abdomen.

Figure HH-1-S1: The IX-EEG recorder with three lead wires and electrodes connected.

7. Snap the lead wires onto the electrodes, so that:

• the red (+1) lead is attached to the left wrist or just under the left clavicle,

• the black (-1) lead is connected to the right wrist or just udner the right clavicle,

• the green (C or ground) lead is connected to the right leg or on the abdomen.

8. Instruct the subject to sit quietly with their hands in their lap. If the subject moves, the ECG 
trace will move off the top or bottom of the screen. If the subject moves any muscles in the 
arms or upper body, electromyograms (EMGs) from the muscles will appear on the ECG 
recording as noise.

Human Heart – ECG and Circulation HH-1-3



iW
or

x S
am

ple
 La

b

Experiment HH-1: The Electrocardiogram and Peripheral Circulation

Exercise 1: The ECG in a Resting Subject

Aim: To measure the ECG in a resting individual.

Procedure

1. Click on the Record button, located on the upper right side of the LabScribe Main window 
(Figure HH-1-L1). The signal should begin scrolling across the screen.

Note: If the user clicks the Record button and there is no communication between the iWorx unit and 
computer, an error window will appear in the center of the Main window. Make sure the iWorx unit is  
connected to the USB port of the computer. Click OK and select the Find Hardware function from the 
LabScribe Tools menu. 

2. Click on the AutoScale button at the upper margin of the ECG channel. Your recording should 
look like Figure HH-1-L2. 

• If the signal is upside down when compared to the trace in the figure, click on the 
downward arrow to the left of the channel title and select the Invert function. The trace 
should now look similar to the one in the figure.

• If a larger ECG signal is required, the electrodes should be moved from the wrists to 
the skin immediately below each clavicle. 

3. When you have a suitable trace, type <Subject’s Name> Resting ECG in the Mark box to the 
right of the Mark button. Press the Enter key on the keyboard to attach the comment to the data. 
Record for a minute or two.

4. Click Stop to halt recording. 

Figure HH-1-L1: The LabScribe toolbar.
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Figure HH-1-L2: ECG displayed on the Main window. 

5. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 
in which to save the file, (like your lab group folder). Designate the file type as *.iwxdata. Click 
on the Save button to save the data file.

Data Analysis 

1. Scroll through the recording and find a section of data with five or six exemplary ECG cycles in 
succession.

2. Use the Display Time icons to adjust the Display Time of the Main window to show at least 
four complete ECG cycles on the Main window. Four adjacent ECG cycles can also be selected 
by:

• Placing the cursors on either side of a group of four complete ECG cycles.

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the 
segment with the four selected ECG cycles to the width of the Main window.

3. Click on the Analysis window icon in the toolbar or select Analysis from the Windows menu to 
transfer the data displayed in the Main window to the Analysis window.

4. Look at the Function Table that is above the uppermost channel displayed in the Analysis 
window. The names of the mathematical functions used in the analysis, V2-V1 and T2-T1, 
appear in this table. The values for V2-V1 and T2-T1 from each channel are seen in the table 
across the top margin of each channel. In this exercise will only need to record the values for 
T2-T1.
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5. Once the cursors are placed in the correct positions for determining the time intervals on each 
ECG cycle, the values of the time intervals can be recorded in the on-line notebook of 
LabScribe by typing their names and values directly into the Journal, or on a separate data table.

6. The functions in the channel pull-down menus of the Analysis window can also be used to enter 
the names and values of the parameters from the recording to the Journal. To use these 
functions:

• Place the cursors at the locations used to measure the period of the ECG cycle.

• Transfer the names of the mathematical function used to determine the time interval to 
the Journal using the Add Title to Journal function in the ECG Channel pull-down menu.

• Transfer the values for the beat period to the Journal using the Add Ch. Data to Journal 
function in the ECG Channel pull-down menu.

Figure HH-1-L3: ECG displayed on the Analysis window with cursors in place to measure the beat 
period with the T2-T1 function.

7. Use the mouse to click on and drag the cursors to specific points on the ECG recording to 
measure the following:

• The beat period, which is the time interval between two adjacent R waves. To measure 
the beat period, place one cursor on the peak of an R wave and the second cursor on the 
peak of the adjacent R wave. The value for T2-T1 on the ECG channel is the beat 
period. Measure the beat period for two additional pairs of R waves. 

Human Heart – ECG and Circulation HH-1-6
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8. Calculate the following values and record your results into the Journal or on a separate data 
table:

• The average beat period, in seconds/beat.

• The heart rate, which is expressed in beats per minute and calculated from the average 
beat period by using the following equation:

• Heart Rate (beats/minute) = 60 seconds/minute
                                                      # seconds/beat

Questions

1. What electrical and mechanical events take place during the R wave?

Exercise 2: The ECG in Other Subjects

Aim: To measure the ECG in other subjects.

Procedure

Repeat Exercise 1 on other subjects. 

Data Analysis 

Analyze the data for each subject using the same techniques used in Exercise 1.

Exercise 3: The Effect of Cold on the Heart Rate

Aim: To measure the effects of cold on the heart rate.

Procedure

1. Click on the Record button. The signal should begin scrolling across the screen.

2. Click on the AutoScale button at the upper margin of the ECG channel. Use the same 
techniques used in Exercise 1 to display the signal properly.

3. When you have a suitable trace, type <Subject’s Name> RoomTempECG in the Mark box to the 
right of the Mark button. Press the Enter key on the keyboard to attach the comment to the data. 
Record for a minute or two.

4. Type Cold ECG in the Mark box to the right of the Mark button. Place a bag containing a 
mixture of ice and cold water on the subject’s left forearm. At the same time, press the Enter 
key on the keyboard to attach the comment to the data. Record for two minutes while the cold 
pack is on the subject’s forearm.

5. Type Remove in the Mark box. Simultaneously remove the ice bag and press the Enter key on 
the keyboard.

6. Record for an additional two minutes; then, click Stop to halt recording.
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7. Select Save in the File menu on the LabScribe window.

Data Analysis

1. Scroll through the recording and find a section of data with four or five exemplary ECG cycles, 
in succession, that were recorded at room temperature.

2. Use the Display Time icons, or the cursors and the Zoom between Cursors button, to adjust the 
Display Time of the Main window to show at least four complete ECG cycles on the Main 
window.

3. Click on the Analysis window icon in the toolbar to transfer the data displayed in the Main 
window to the Analysis window.

4. Look at the Function Table in the Analysis window and make sure the mathematical functions 
used in the analysis, T2-T1, appears.

5. Once the cursors are placed in the correct positions for determining the time intervals, transfer 
the names and values of the parameters measured in the Analysis window to the Journal using 
one of the two techniques described in Exercises 1, or transfer the values to a separate data 
table.

6. Use the mouse to click on and drag the cursors to specific points on the ECG recording to 
measure the following:

• The beat period. Measure the time between two adjacent R waves using the same 
technique employed in Exercises 1 and 2. Determine the beat period for three ECG 
cycles.

7. Repeat Steps 5 and 6 for the data at 1 and 2 minutes into the cooling period, and at 1 and 2 
minutes into the rewarming period

8. Calculate the following values and type your results into the Journal or on a separate data table:

• The heart rate while the forearm was at room temperature, cooled for 1 and 2 minutes, or 
rewarmed for 1 and 2 minutes.

Questions

1. Does cooling of the forearm affect the heart rate?

2. Through what mechanism does cooling affect the peripheral circulation?

3. What other factors may affect peripheral circulation?

Exercise 4: The Effect of Heat on the Pulse

Aim: To measure the effects of heat on the pulse and heart rate.

Procedure

1. Follow the directions used in Exercise 3 to do an experiment on the right forearm of the subject 
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with a bag of warm water. Mark the recording to indicate when the bag of warm water was 
applied and removed from the forearm.

Questions

1. Does warming of the forearm affect the heart rate?

2. Through what mechanism does warming affect the peripheral circulation?
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